
 

  

Creating a Video in 

Camtasia 
      
 

Creating a Video in 

Camtasia 
      



 

1 

Table of Contents 
Before You Start ................................................................................................................................................ 2 

Starting a New Camtasia project..................................................................................................................... 3 

Aspect Ratios ............................................................................................................................................... 3 

Importing Media ........................................................................................................................................... 3 

Saving a Project File, Opening a Project in Progress .................................................................................. 4 

While You are Editing .................................................................................................................................. 4 

Saving a Project in Progress ....................................................................................................................... 4 

Opening a Zipped Camtasia Project ........................................................................................................... 4 

Camtasia Overview and Layout ...................................................................................................................... 5 

Timeline and Toolbar ...................................................................................................................................... 5 

Basic Editing and the TIMELINE TOOLBAR .............................................................................................. 6 

To Cut/Paste/Undo: ..................................................................................................................................... 6 

Splitting ........................................................................................................................................................ 6 

Trimming ...................................................................................................................................................... 6 

Tracks .............................................................................................................................................................. 7 

Adding Media to Tracks ............................................................................................................................... 7 

Canvas and Properties Pane .......................................................................................................................... 7 

To Activate the PROPERTIES PANE: ........................................................................................................ 8 

Tools ................................................................................................................................................................... 8 

Annotations...................................................................................................................................................... 8 

To Add an Annotation: ................................................................................................................................. 8 

To Modify Annotations: ................................................................................................................................ 8 

Transitions ....................................................................................................................................................... 9 

To Add Transitions ...................................................................................................................................... 9 

To Modify Transitions .................................................................................................................................. 9 

Recording in Camtasia .................................................................................................................................... 9 

To Record .................................................................................................................................................. 10 

Export and Submit .......................................................................................................................................... 10 

To Export ................................................................................................................................................... 11 

To Submit .................................................................................................................................................. 11 



 

2 

Before You Start 

• Camtasia is a software with two major components: a recorder to capture audio and video, and an 

editor for managing a variety of file formats in TRACKS on a TIMELINE. Camtasia allows for 

creativity with options like transitions and callouts.  

• Along with this guide, free Tutorials are available online and by accessing Help in Camtasia. 

 
 

https://www.techsmith.com/tutorial-camtasia.html 

• Ask a librarian in person, via chat, email, or phone for help. We recommend you schedule a time for 

help one on one in person or online:   

https://lib.morainevalley.edu/Main/AskLibrarian.html  OR 

• Equipment to capture audio and video is available for checkout with a student ID. The library offers 

Camtasia outside of the library via Mobile Media Lab laptops also available for checkout. 

https://lib.morainevalley.edu/libservices/technologyonreserve.html 

• To reserve space to capture and edit media, the library offers study rooms and seats in the Media 

Lab. 

https://lib.morainevalley.edu/LibServices/SelfSchedule.html 

• SAVE EARLY AND OFTEN! Google drive or USB file storage is recommended. Create a folder and 

store ALL of your project files in that folder.  

• Always consider a copyright holder's rights when choosing images, songs, videos or other sources. 

For more information on open license media: 

http://lib.morainevalley.edu/guides/OpenLicenseMedia.html 

  

https://www.techsmith.com/tutorial-camtasia.html
https://lib.morainevalley.edu/Main/AskLibrarian.html
https://lib.morainevalley.edu/libservices/technologyonreserve.html
https://lib.morainevalley.edu/LibServices/SelfSchedule.html
http://lib.morainevalley.edu/guides/OpenLicenseMedia.html
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Starting a New Camtasia project 

Open Camtasia and click NEW PROJECT 

 

RECORD or IMPORT videos, images, and audio files into the MEDIA BIN. Many file types can be imported 

including mp3, mp4, .jpg, PowerPoint slides and more. 

 

Aspect Ratios  

The default aspect ratio for a Camtasia project is 720p HD. This 

is an optimal aspect ratio for most projects.  

• Click on the aspect ratio drop down menu above the 

Canvas.  

• Select “Project Settings” and check that 720p HD 

(1280x720) is selected 

 

Importing Media  

• Click “IMPORT MEDIA” or the plus (+) sign in the 

MEDIA BIN.  

• Find the source folder and media files and click on 

files to import.  

• Click “Open” and the imported files will appear in 

the MEDIA BIN. 

 

Quick Tip: 

**To add your imported media, recorded video or audio to a video, drag from the MEDIA BIN 

onto a TRACK in the TIMELINE. See the Recording section on page 9 for more about recording 

video and audio in Camtasia.  
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Saving a Project File, Opening a Project in Progress 

 

While You are Editing 

• Save early and often! 

• Open the File menu and select Save or Save As. 

This will create an editable Camtasia project file 

(.cmprog). **This is not the final video or the file 

you will turn in!** 

 

Saving a Project in Progress  

• To continue editing at a later time, it is 

important to save the Camtasia project file 

(.cmprog) and all media files together. The 

best way to do this is to create a .zip file.  

• To create a .zip file: 

o On a Mac: Open the File menu and 

select “Export for Windows” 

o On a PC: Open the File menu and 

select “Export as .zip” 

• Save the zipped file to a flash drive or Google 

Drive.  

Opening a Zipped Camtasia Project 

● On a Mac or PC: Open the File menu and 

select “Import Zipped Project” 

Mac PC 

Quick Tip: 

For a group project, it is important to 

share media and project files with all 

group members. 

• Sharing files using 

Google Drive is one 

easy way to do this.  

• Upload your .zip file to Google 

Drive and share it. 
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Camtasia Overview and Layout 

There are four main areas in Camtasia--the TIMELINE and TOOLBAR, the CANVAS, PROPERTIES 

PANE, and TOOLS PANEL. 

 

 

 

Timeline and Toolbar 

The TIMELINE and TOOLBAR are used to assemble, manage and edit media in a video. The TIMELINE is 

one editing area, the CANVAS is another. The TIMELINE displays the sequence of all media and elements 

in a video.  
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Basic Editing and the TIMELINE TOOLBAR  

• Click to select media in the TIMELINE to edit, move, 

or delete. The selected media will have a yellow 

border. 

• To deselect, click on a different clip or a blank section 

on the TIMELINE. 

• For more precise selections, drag the Zoom slider to 

zoom in on the TIMELINE content. 

 

To Cut/Paste/Undo: 

• Select media on the TIMELINE and click the 

Cut button  or hit delete on your keyboard. 

• To Paste a selection on the TIMELINE, click in the 

TIMELINE or move the PLAYHEAD to a new location 

and click the Paste button . 

• To undo click the Undo button.  

Splitting  

• Split to separate media into multiple clips.  

• Select the clip to split. Position the PLAYHEAD at the desired split location. 

• Click split in the TIMELINE TOOLBAR  . 

Trimming 

• Trim to adjust the length of a clip, usually at the beginning or 

end. 

• To trim, move the cursor over the end or beginning of a clip.The 

cursor will change; click and drag the end of the clip to the 

desired point. Or, use the PLAYHEAD handles to select an 

areas and cut or delete the selected area. 

Quick Tip: 

The PLAYHEAD marks the location on 

the TIMELINE of the media currently 

displayed on the Canvas. 

 

• Move the PLAYHEAD by clicking in 

the TIMELINE or dragging the 

PLAYHEAD to another position. 

• During playback, Start or stop the 

PLAYHEAD using the spacebar.  

• Click and drag the red and green 

PLAYHEAD handles to make a 

selection. Double click on the 

PLAYHEAD to bring it back together. 
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Tracks  

An unlimited number of tracks can be added to the 

TIMELINE. To add a “new” track click the plus (+) sign 

under the TIMELINE TOOLBAR.   

 

Adding Media to Tracks 

• Drag and drop media from the MEDIA BIN onto a blank area of the TIMELINE. 

• Move media by clicking and dragging anywhere in tracks on the TIMELINE.  

• Media can be stacked in tracks on top of each other. Tracks with a higher number will layer over 

tracks below. For example, if you have a video in Track 1 and a photo in Track 2, the photo will 

cover the video unless you resize it. 

Canvas and Properties Pane 

 

The CANVAS, or fine-tuning window, is the working area where you preview, arrange, rotate, and resize 

media and other elements. The PROPERTIES PANE contains a series of menus that allows for further 

customization of media, annotations, behaviors, and effects. 

• To select an element on the CANVAS, click on it. When you select an element on the CANVAS it is 

also selected in the TIMELINE--and vice versa.  

• All media must be within the frame on the Canvas. Anything outside the frame border will not 

appear in the final video.  
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• To move, resize, or rotate an element: 

o To move: Click and drag to a new location on the CANVAS. 

o To resize: Click on an element and drag the image handle in or out to the desired size. 

o To rotate: Drag the center image handle and turn. Press and hold the ALT key while 

dragging for 3-D rotation. 

• To select more than one element, press and hold the Shift key and click on elements.  

 

To Activate the PROPERTIES PANE: 

• Click the Properties button.   

● The media or element that is selected on the CANVAS will have different customization options 

available. 

Tools 

 

The TOOLS PANEL allows you to add visual and audio elements and effects to a video.  

 

Annotations 

Annotations allow you to add content and emphasis through the 

addition of text and callouts like arrows, lines, shapes, and other 

effects. 

 

To Add an Annotation: 

• Select annotations in the TOOLS PANEL. View different 

annotation options using the menu at the top. 

• Drag and drop animations from the Annotations menu onto 

the CANVAS or TIMELINE. 

• Add annotations to the CANVAS or TIMELINE in a new or 

existing track.  

To Modify Annotations: 

• To rotate or resize an annotation, click on it in the CANVAS. 

Use the shape handles to make adjustments. 

• To edit text, double click on the annotation in the CANVAS.  
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• To further modify an annotation, select it and open the PROPERTIES PANE for options.  

Transitions  

Transitions provide a way to join or distinguish between media clips. 

 

To Add Transitions 

• Select the Transitions menu in the TOOLS 

PANEL. 

• Hover your mouse over a transition to 

preview the effect. 

• To add a transition, drag it to the TIMELINE 

and drop it at the beginning or end of a clip. 

To Modify Transitions 

• To modify a transition, zoom in on the TIMELINE.  Click to select 

the transition you wish to modify. 

• Drag the handles at the beginning or end of the transition to extend 

or reduce the duration.  

• To use a different transition, drag and drop another style over the 

previous transition. 

Recording in Camtasia 

There are various ways to record in Camtasia: 

• Screencapture--record the screen and other actions taken on your computer 

• Webcam—use a built-in camera or accessory webcam* to record content 

• Microphone*--record with a built-in or external microphone to add narration 

  

Quick Tip: 

*Equipment like headphones, microphones, and webcams are available for check out with your 

student ID at the library’s circulation desk: 

https://lib.morainevalley.edu/libservices/technologyonreserve.html 

https://lib.morainevalley.edu/libservices/technologyonreserve.html
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To Record 

• Check and test the audio level of the microphone.  

• Click Record at the top left of the screen. The Camtasia window will minimize and the 

CAMTASIA RECORDER box will appear.  

• Turn audio and video input options on or off using the toggle buttons or dropdown menus.  

 

• Use the dropdown menus under each input to select a microphone or webcam.  

• Click “Start Recording” and the CAMTASIA RECORDER box will minimize and recording will begin 

after the countdown. 

• To stop recording: 

o On a PC 

▪ Click the Camtasia recorder icon in the taskbar, then the stop button. If you need to 

re-record, choose delete to start over. 

▪ Quick Tip: Press “F10” to stop a recording, or “F9” to pause/resume a recording. 

o On a MAC 

▪ Click the Camtasia icon in the Apple menu bar, then click “Stop Recording.” If you 

need to re-record, choose “Start Over.” 

▪ Quick Tip: Press “CMD+OPTION+2” to stop a recording, or “CMD+SHIFT+2” to 

pause/resume a recording. 

• Recordings will automatically be added to the MEDIA BIN.  

Export and Submit 

 

Exporting creates a video in a file format that can be shared and viewed by media players. 

 

***Before you export, save your completed project as a .zip file. See the Saving a Project in Progress 

section on page 4.*** 

 

  

Mac PC 
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To Export  

• Click on the “Share” menu, select “Local File.” 

o Set it to export as an MP4 (720p). 

o Give the video file a descriptive name and save it 

to the Desktop or external drive. 

To Submit  

● Submit the MP4 according to the guidelines of the 

assignment as outlined by your instructor—i.e., using 

Google Drive, Canvas, Panopto, YouTube, etc.  

Quick Tip: 

• Ask a librarian in person, via chat, email, or phone for help. We recommend you schedule a 

time for help one on one in person or online:   

https://lib.morainevalley.edu/Main/AskLibrarian.html       OR 

 

https://lib.morainevalley.edu/Main/AskLibrarian.html
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